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Foreword 

This user guide accompanies the Beta EBNT QGIS Template, which provides an optional 

extension for more technical users working on larger and more complex projects. Files 

required to complete the tasks and modules set out in this user guide are found within the 

EBNT QGIS Template Zip folder.  

The EBN QGIS user guide should be used alongside the main EBNT User guide to ensure 

data is entered correctly into the EBN tool.  Use of the EBNT Data Catalogue is also 

required to provide necessary details for non-mapped datasets, such as landscape 

diversity and to provide details of non-Open Government Licenced datasets (such as soil 

drainage) or non-server-based data (such as population density and public access 

information) which are not available through this template. Information for these indicators 

should be entered directly into the EBNT tool. 

As with other user guidance, this template should be used having first read the EBNT 

Principles to ensure a reasonable understanding of how the tool operates and should be 

used and interpreted.  

PLEASE NOTE: This product is in Beta Development and reliant on stable access to 

Government Servers, which may be subject to offline periods for essential maintenance 

and/or future change. Should you experience any issues using the product or accessing 

the Government servers via the tool - that cannot be addressed using the troubleshooting 

list below - please contact ebn@naturalengland.org.uk. 

V1-1 has been updated to make limited changes to account for changes to 

government server relating to nature designations – see Annex 2 for a full list of 

changes made.  

 

 

  

mailto:ebn@naturalengland.org.uk


 

Page 4 of 36 EBNT QGIS User Template - Beta version 1-1 JP038 

 
 

Contents 

Project details ...................................................................................................................... 2 

Foreword .............................................................................................................................. 3 

1. Introduction ...................................................................................................................... 5 

Before you start ................................................................................................................ 5 

File Structure .................................................................................................................... 6 

QGIS Template layers, layer group and models ............................................................... 6 

2. Getting Started, running models ...................................................................................... 7 

Running Models ................................................................................................................ 8 

BNG Habitat Data Import Model ....................................................................................... 9 

Indicator Data Import Model ........................................................................................... 14 

Data Intersect Model ...................................................................................................... 17 

Data Aggregate Model .................................................................................................... 19 

Reset All Layers Model ................................................................................................... 22 

3. Exporting Tabular data to the EBNT .............................................................................. 22 

4. Checking and editing entered data in the EBNT ............................................................ 27 

5.Troubleshooting .............................................................................................................. 27 

Annex 1. Data Layers ........................................................................................................ 28 

  



 

Page 5 of 36 EBNT QGIS User Template - Beta version 1-1 JP038 

1. Introduction 

The Beta Environmental Benefits from Nature (EBN) Tool QGIS Template has been 

designed to support QGIS users working on larger or more complex projects. It is intended 

to complement the updated EBNT v1-1 tool by providing a faster, custom, means of data 

access and processing. It allows the user to match mapped habitat data (required by 

Biodiversity Net Gain (BNG)) to the contextual counterparts required by the EBNT, to 

support a BASIC level assessment of ecosystem service change. 

The following user guide provides step-by-step instructions to allow users to go from a 

completed Biodiversity Metric QGIS template starting point, to a completed assessment in 

4 easy steps. While aimed at technical QGIS users, the instructions do not require a 

specific knowledge of QGIS or QGIS programming.  

The EBNT QGIS Template has been designed as an extension to the Biodiversity Metric 

QGIS Template. Spatial habitat data produced by any other means will not be compatible 

with this project and should be first transferred into the Biodiversity Metric- QGIS Template 

before proceeding. Further information on the Biodiversity Metric QGIS Template and 

other supporting resources can be found at The Biodiversity Metric Supporting Documents 

- JP039 (naturalengland.org.uk) 

Before you start 

1. Ensure the correct version of QGIS is downloaded - The EBNT QGIS template 

was created and tested in QGIS 3.34.4 (Version “3.34”, sub version “.4”), which at 

the time of development was the stable long-term release (LTR). It is therefore 

recommended that QGIS version 3.34 (any sub-version) is downloaded and used to 

follow the below guidance. This is available to download from the QGIS Project 

webpage https://www.qgis.org/en/site/index.html. 

Once 3.34 is no longer the long-term release, it will still be available from the “All 

Releases” page in the downloads section of the QGIS website 

https://www.qgis.org/en/site/forusers/download.html.    

2. Ensure you have the correct habitat data in the correct format The EBNT QGIS 

Template is designed to work with the QGIS Template for the statutory biodiversity 

metric tool, link below: 

https://publications.naturalengland.org.uk/publication/6049804846366720 

Use of earlier versions of the QGIS Template will result in the EBNT QGIS 

Template failing to function correctly. 

3. Ensure the QGIS settings are set to the following to ensure best performance 

– Go to Settings->Options->Processing->Invalid Features.  Filtering needs to be set 

to “Do not filter (better performance)” – failure to do so can cause issues accessing 

contextual data (see Troubleshooting). 

4. Ensure measurement units are hectares for area and kilometres for length 

– Go to Project->Properties->General->Measurements->Units for distance 

measurement = Kilometres.  

https://www.qgis.org/
https://publications.naturalengland.org.uk/publication/6049804846366720
https://publications.naturalengland.org.uk/publication/6049804846366720
https://www.qgis.org/en/site/index.html
https://www.qgis.org/en/site/forusers/download.html
https://publications.naturalengland.org.uk/publication/6049804846366720
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–  Go to Project->Properties->General->Measurements->Units for area 

measurement = Hectares.   

5. Familiarise yourself with the EBNT QGIS File Structure & layers, layer groups 

and models– see below. 

File Structure 

The EBNT zip folder contains two QGIS project files and a folder containing four 

GeoPackages. 

Figure 1. Files and folder in the EBNT QGIS Template Folder 

 

The first project file “NE – EBNT – Template” is the main project file undertakes the 

following: 

• Import habitats from the Biodiversity Net Gain/ Biodiversity Metric QQGIS Template 

files. 

• Import indicator data from online data sources. 

• Intersect habitat data with indicator data. 

• Consolidates spatial data and creates the output table that will then be inputted into 

the EBNT calculator spreadsheet. 

The second project file “NE – EBNT – Indicator Layers” contains connections to all EBNT 

indicator data sources and allows users to view these datasets in their entirety and can be 

used as a reference but will not undertake any of the geoprocessing as described above. 

The folder “DataLayers” contains four GeoPackages. The geoprocessing tasks 

undertaken by the “NE – EBNT – Template” will automatically save the results to these 

GeoPackages and user will not have to access these files manually.  

QGIS Template layers, layer group and models 

The EBNT QGIS Template contains 27 spatial layers within 5 layer groups which are 

automatically populated by a series of QGIS Models. A QGIS model is a collection of 

commands and calculations such as buffers, union and intersections that run in a 

predefined sequence to undertake complex geoprocessing. 
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The layers and layer groups in the EBNT QGIS Template are: 

• A site boundary which contains the site boundary extracted from the Biodiversity 

Net Gain, Biodiversity Metric QGIS Template files. 

• Habitats group which contains Tree, Hedgerow, Watercourse and Habitat layers 

extracted from the BNG/ Biodiversity Metric QGIS Template files.  

• Indicators group which contains a series of layers which contain a subset of 

spatial data extracted from online data sources based on the projects site 

boundary.     

• Intersection Group contain the results of the intersection between the BNG/ 

Biodiversity Metric habitat layers and the indicators data.  

• Basemaps Group contains a GB outline map. 

• Output Tables Group contains the tables that will by inputted into the EBNT 

calculator spreadsheet. 

Figure 2. Screen Shot showing initial GB Outline Map generated on opening the 

template 

 

2. Getting Started, running models 

The EBNT QGIS Template uses 4 key models to run the key tasks required to complete 

an assessment. These need to be completed in order as set out in the section below. 

These are:  
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1. 001 BNG Habitat Data Import Model– transfers habitat and site boundary 

information from the BNG/Biodiversity Metric QGIS template to the EBNT template, 

ready to be matched to contextual data. 

2. 002 Indicator Data Import Model – accesses Government servers to pull the 

relevant contextual datasets required by the EBNT relevant to the site area. 

3. 003 Data Intersect Model – “cookie cuts” contextual data overlapping each habitat. 

4. 004 Data Aggregate Model – groups data with shared attributes prior to export. 

Details on how to execute each model are provided below and include final reset model 

allows the template to be reused. 

Running Models 

To run a model, select “Models” from the “Project” menu, select the model you want to run 

then “Execute”. 

Figure 3. Screenshot showing how to select “models” from QGIS Project Menu 
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A new, model dialog box will appear. If the model requires user input, such as a file path, 

this must be provided before running the model. To run the model, after any additional 

data has been supplied, press “Run”. 

In total, the EBNT QGIS Template has five models available. As stated above, the first 

four carry out the required geoprocessing for an EBNT assessment and will be described 

in more detail below. The fifth model deletes all data created by the other 4 models 

resetting the template.  

BNG Habitat Data Import Model 

The first model “001 BNG Habitat Data Import” requires the user to define the location of 

the BNG/Biodiversity Metric QGIS Template GeoPackage files. To provide the file’s 

location press on the three dots on the right side of the input box. 

Figure 4. Screenshot showing the prompt to select file location in Model 001  

 

Go to the folder location that contains the BNG/Biodiversity Metric QGIS Template files 

and then open the “Layers” folder. Select the file named “Net Gain Habitat Mapping 

Layers.gpkg”.  
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Figure 5. Screenshot showing the Layers folder and mapping layers found within it 

where Net Gain Habitat mapping layers should be stored 

 

Once the file has been selected, press run.  

Figure 6. Screenshot showing file path to selected habitat data layer 

 

When running, the model will output some text to the model window. If the model has run 

successfully, the output will appear as below. 
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Figure 7. Screenshot showing dialogue box generated on successful output 

 

The model window can now be closed which will return you back to the main map canvas. 

The site boundary will appear when the map canvas is refreshed. This can be done by 

scrolling or zooming the map, pressing the refresh button in the “Map Navigation Toolbar” 

or by pressing F5. 

In the test data shown in this user guide, the site is located near Scarborough in North 

Yorkshire and can be seen at the scale below as a red dot. 
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Figure 8. Screenshot showing site boundary generated on open GB canvas (test 

example) 

 

Using standard QGIS tools, zoom to the site boundary. The test data shown in this user 

guide is based on a hexagonal grid and is unlikely to resemble a standard assessment 

site. 

Figure 9. Screenshot showing zoomed simplified site boundary (test example)
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When zoomed to the site boundary the habitats layer group should now be turned on to 

show the tree (green dots), hedgerow (brown lines), watercourse (blue lines) and area 

habitats (green outline) that have been imported from the BNG/ Biodiversity Metric file. 

Figure 10. Screenshot showing site boundary (red) with habitat layer switched on 

showing trees (green) hedgerow and water course data (test data) 

The “001 BNG Habitat Data Import” model imports the relevant data from the Biodiversity 

Metric BNG files and also converts BNG categories into the EBNT equivalents including 

the baseline and proposed habitat types. 

If a habitat type is not recognised due to a missing value, one that has been manually 

changed, or if the BNG data has been created in an unsupported version of the 

Biodiversity Metric QGIS Template the following will be displayed in the attribute table as 

“*****ERROR - HABITAT TYPE NOT FOUND*****”. 

It is advised that the attribute tables for all four different habitat types (tree, hedges, 

watercourses and area habitats) are checked for errors and corrected either in the original 

BNG Biodiversity Metric QGIS file or in the EBNT layer before running the second model.  

Optional Data Input – Width and Starting Habitat 

In addition to the spatial data extracted from the BNG/ Biodiversity Metric QGIS Template 

files, the EBNT assessment also requires the width of hedgerows and watercourses to 

calculate their area and the starting habitat for newly created habitats. Width data will 

default to 1m for hedgerow and watercourse habitats and for newly created habitats the 

“Starting Habitat” will default to “Soil removed”. If these defaults are not appropriate, then 
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open the attribute table for the habitat layers and change the value from the default to a 

more accurate value. 

Indicator Data Import Model 

The second model “002 Indicator Data Import” controls the import of the EBNT indicator 

data. 

This model should only be run once the first model has been run as the indicator data will 

be imported based on the location of the site boundary. 

To run the model, select “Models” from the “Project” menu, then select “002 Indicator Data 

Import” then “Execute”. 

Figure 11. Screenshot showing selection of model 002. to import indicator data 

 

This model does not require user input and so will not open a model dialog box but will 

show a progress bar at the top of the screen. 

Once the model has completed, turn off the habitats layer and expand the indicators 

group. 

You can now view the spatial data created for each of the EBNT indicators by turning on 

and off the relevant layer. Please note that indicator data extracted from the online data 
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sources will extend past the site boundary. Do not manually clip this data to the site 

boundary as this may lead to later models not functioning correctly.  

Figure 12. Screenshot showing selection of Agricultural Land Class data within the 

site – different colours display different grades of land 

 

This model accesses online data held across different Government servers. Occasionally 

the connection to these temporarily fails which will cause this model to fail. If this occurs 

you can run the model again which will usually then run successfully.  

Only indicators hosed on Government servers with open government licences (OGL) will 

populate. The indicators that require manual data entry are: 

• Soil Drainage (dataset available on MAGIC for non-commercial use / or purchase 

for commercial use from https://www.landis.org.uk). 

• Population Density (viewable on Green Infrastructure data portal / download from 

https://www.ons.gov.uk/datasets/TS006/editions/2021/versions/4). 

• Public Access (viewable on Green Infrastructure data portal / download from 

https://www.data.gov.uk/dataset/f335ab3a-f670-467f-bedd-80bdd8f1ace6/green-

and-blue-infrastructure-england) 

• Education Use. Using Public access (as above and local knowledge). 

• Landscape Diversity (requires manual assessment see EBN Data Catalogue for 

instruction). 

 

Manual Editing of Indicator Data 

If additional data is known about any of the other indicators, such as adding local wildlife 

sites to the nature designation layer then these layers can also be edited. Please note, 

https://www.landis.org.uk/
https://designatedsites.naturalengland.org.uk/GreenInfrastructure/Map.aspx
https://www.ons.gov.uk/datasets/TS006/editions/2021/versions/4
https://designatedsites.naturalengland.org.uk/GreenInfrastructure/Map.aspx
https://www.data.gov.uk/dataset/f335ab3a-f670-467f-bedd-80bdd8f1ace6/green-and-blue-infrastructure-england
https://www.data.gov.uk/dataset/f335ab3a-f670-467f-bedd-80bdd8f1ace6/green-and-blue-infrastructure-england
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where multiple attributes are present such as “Site Name” and “Designation” e.g. in the 

Nature Designation layer, then please enter data for all of the attributes - as these are 

used to calculate the final indicator values.   

This user guide does not provide details of data entry in QGIS but recommends the 

following: 

• For layers that have been pre-populated with a polygon or polygons that form a 

continuous area that covers the whole site boundary, such as soil drainage, use the 

“split features” and “fill ring” tool from the advanced digitising toolbar to subdivide 

the existing polygon. Do not add additional polygons or make the area smaller by 

deleting parts. 

Figure 13. Screenshot showing how a manual intersection of a data layer should 

look once complete (left: original layer, right: after manual intersection)  

 

• For layers where the layer does not fully cover the entire site boundary area, such 

as “Nature Designation”, “Cultural or Historic Importance” and Special Recreation 

Value, then simply use the “Add polygon feature” tool from the Digitising toolbar. 

Figure 14. Screenshot showing additional data – Local Wildlife Site manually added 

(right) 

 

Once any additional data has been added to these layers, and saved, the next model can 

be run. 
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Please note, if this model is run for a second time after any data has been manually 

edited, those changes will be lost and replaced with the standard data set based on the 

spatial data stored on the online data servers. 

Data Intersect Model 

The third model “003 Data Intersect” intersects the BNG Biodiversity Metric habitat data 

boundaries with the indicator data boundaries, subdividing the habitat parcels further if an 

indicator boundary passes through the parcel. 

This model should only be run once the first two model have been run as it requires both 

habitat data from the Biodiversity Metric QGIS files and indicator data from the online data 

sources. 

To run the model, select “Models” from the “Project” menu, then select “003 Data Intersect 

then “Execute”. 

Figure 15. Screenshot showing selection of 003 intersect model 

 

As with the previous model, this model does not require user input and so will not open a 

model dialog box but will show a progress bar at the top of the screen. 

Once the model has completed, turn off the indicators layer group and expand the 

indicators group. 
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Turning on the area habitats, hedgerows and watercourses layers will show the new 

intersected boundaries and opening the attribute tables will show the indicator values for 

each habitat parcel (or line).  

Figure 16. Screenshot showing the results of the intersection of habitat parcels with 

the indicator layers 

 

Trees 

As trees are defined spatially as points these features cannot be intersected, but the 

attribute table will show the indicator values of the indicator parcels they fall within. Where 

they fall on the boundary between two indicator values, the higher value will be selected. 

Watercourses 

Watercourses form a special case as they require the comparison of line data with line and 

also polygon data. Where watercourse lines are compared to line data in the indicator 

data, it is unlikely that both data sets (even when relating to the same watercourse) will 

align precisely. Therefore, watercourse lines are subdivided and compared to the indicator 

data sets with a buffer distance. If a section of a watercourse deviates more than 10m 

from how it is represented in the indicator dataset then that section will be displayed as NK 

for those indicator values. This is especially true with Water Quality WFD Status and 

therefore it is suggested that for watercourses, the indicator values assigned are manually 

checked and manually edited before running the final model. 
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In the intersection layers group, trees, hedgerows and habitats are styled the same as the 

habitats layer. Watercourses however are styled based on the Water Quality WFD Status 

for each of manually verifying these attribute values as described above.  

Not Known “NK” vs “No” 

“Ancient Habitats”, “Special Recreation Value” and “Managed for Nature” all have “Yes” or 

“No” value options. When the model intersects these layers with the habitat layers all 

values are either set to “Yes” where an overlapping feature is present or “NK” when no 

feature has been imported. If by using knowledge of the site, and any other data sources 

available to the user, there is certainty that the indicator value should be “No” and not “NK” 

this value can be changed in the attribute table to reflect this before running the final Data 

Aggregate Model.  

Data Aggregate Model 

The final model, “004 Data Aggregate” undertakes the following steps: 

• Merges trees, hedges, watercourses and area habitats into a single layer.  

• Splits baseline and proposed habitats into two separate layers. 

• Changes all indicator values to NA where that indicator value is not applicable for 

that habitat type. 

• Aggregates areas of the same habitats together that also share the same indicator 

values. 

The aggregate model also has an optional spatial aggregate option that merges areas 

below a defined threshold into adjacent areas and adopts the adjacent indicator values. 

This can be useful in large complex sites, but be aware that while total area will remain the 

same, habitat values will also be merged as well as indicator values, reducing the 

precision of the assessment. 

To run the model, select “Models” from the “Project” menu, then select “004 Data 

Aggregate” then “Execute”. 
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Figure 17. Screenshot showing selection of 004 Model from the Project Menu 

 

To use the optional spatial aggregation, enter a value in the text box. The value is in 

hectares so a value of 0.01 will merge any areas smaller than 10 x 10 metres. Entering a 

zero value will result in no spatial aggregation.  

Figure 18. Screenshot showing the dialogue screen to select minimum area to be 

merged 

 

Once the model has completed running, close the dialog window. There will be no spatial 

output but an output of two tables found in the “Output Tables” layer group. Open the 

attribute table for these layers to view the table data. 
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Figure 19. Screenshot showing the output tables linking the contextual data to 

habitats in the format required for EBNT

 

The model will also save these results to .csv files in the EBNT project folder, ready to be 

copied into the EBNT spreadsheet via the additional data import tool. 

Figure 20. Screenshot showing new csv files added to the QGIS folder for Baseline 

and Proposed works ready for export into the updated EBNT 

 

Watercourse footprint 

Please note, if your BNG QGIS habitats included “Watercourse Footprint” which is used in 

BNG/Biodiversity Metric template as a visual layer only and not used in any of the BNG 

calculations, this will be removed during the aggregation process. The area occupied by 

watercourses is calculated by the watercourse length and width and therefore watercourse 

footprint is removed to avoid double counting of these areas. 
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Reset All Layers Model 

The final model is not required to undertake an EBNT assessment. Its function is to reset 

all of the layers within the QGIS Project by deleting all features.  

3. Exporting Tabular data to the EBNT 

The QGIS EBNT Template is accompanied with an additional data import to allow data 

transfer between QGIS and the EBNT spreadsheet. 

This tool will be found within the same folder as the QGIS EBNT Template. 

Figure 21. Screenshot showing the NE EBNT Data Import Tool selected 

 

Before using this for the first time this file will need to be unblocked. Right click on the file, 

open its properties, check the “Unblock” box and click ok.  

Figure 22. Screenshot showing details of the EBNT import tool unblocked 
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Open the file and press the “Enable content” button 

Figure 23. Screenshot showing details of the EBNT import QGIS Data Import tool

 

The tool is now ready to run. Press the “Run Data Import" button and you will be asked to 

“Select Destination Workbook” which should be a blank copy of the EBNT Spreadsheet.  

Figure 24. Screenshot showing destination workbook highlighted 
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Find and select the file and press ok. The EBNT Spreadsheet will open and then you will 

then be prompted to supply the baseline habitat data file that is created by the QGIS 

EBNT Template.  

Figure 25. Screenshot showing the prompt to select csv file 

 

Press OK and locate the baseline habitat data file which will be in the same folder as your 

EBNT QGIS project file and again press ok. 

Figure 26. Screenshot showing the baseline csv file downloaded 
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You will then be prompted to supply the proposed habitat data file. 

Figure 27. Screenshot showing the prompt to select post-intervention data 

 
Press OK and locate the proposed habitat data file which will be in the same folder as your 

EBNT QGIS project file and again press OK. 

Figure 28. Screenshot showing the post-intervention data csv selected 

  

If the data import has been successful then this will be confirmed by a dialog box.  
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Figure 29. Screenshot confirming the data import is complete 

 

The data import tool can now be closed, if prompted to save select don’t save, and the 

EBNT Spreadhseet will now contain the data generated by the EBNT QGIS Template 

transferred. 

Figure 30. Screenshot showing data successfully imported with missing data 

highlighted in yellow
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4. Checking and Editing Entered data in the 

EBNT 

Once exported to the EBNT, the data should be checked and edited using the EBN User 

Guide and EBN Data Catalogue to ensure data entries have been entered correctly and 

gaps in data entry have been filled. Examples of gaps that will need to be filled include 

landscape diversity, which is not linked to use of spatial data, soil drainage which uses 

data not available under Open Government Licence and population density/public access 

data – which is not yet available via an active server link, but may be accessed via the GI 

data portal. Users should also note that indicators will receive a NK return if no attributes 

are found from the server data requested, these will appear as highlighted gaps within the 

EBNT if not manually corrected/entered (see NK vs No p18). In these cases, if not already 

manually corrected, as part of earlier stages within QGIS, the EBN data catalogue should 

be consulted to manually complete the entry within the EBN Tool. 

5.Troubleshooting 

Successful use of the EBNT template is dependent on following the above instructions but 

can be impacted by external factors such as server updates which may impact operations. 

Before reading the following section, ensure you are using the corresponding version of 

EBNT QGIS and BNG QGIS Template. 

Issue 1: 002 Indicator Data Import Model. Indicator datasets failing to import (i) – 

server issues. 

The following error message is generated when the model is having trouble accessing one 

of the different servers required to access the data.  Such issues are relatively infrequent. 

When this message is generated, it is suggested that the user pauses (checks internet 

connection) and repeats the model at a later time. 

 

https://designatedsites.naturalengland.org.uk/GreenInfrastructure/Map.aspx
https://designatedsites.naturalengland.org.uk/GreenInfrastructure/Map.aspx
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Issue 2: 002 Indicator Data Import Model. Indicator datasets failing to import (ii) – 

incorrect QGIS processing settings. 

The following error message is generated if the Processing settings have not been 

changed as outlined in the “Before you start” section. 

Go to Settings->Options->Processing->Invalid Features and set to “Do not filter (better 

performance)” 

 

Issue 3. 002 Indicator Data Import Model. Indicator datasets failing to import (iii) – 

persistent server issues. 

If issues with data access persists it is possible that the location of one or more servers 

has been changed. In such cases, it will not be possible to complete module 2.  Please 

contact ebn@naturalengland.org.uk to flag the issue and receive further advice.  

Issue 4. NK returned for multiple values – highlighted as gaps in the EBNT 
As covered in section 4. Certain sections require manual data entry/ confirmation (if no 
entry is found - see EBN Data Catalogue. 

Annex 1. Data Layers (2024) 

Indicator Data source 

webpage 

Server Link 

Agricultural 

Land 

Classification 

https://www.data.go

v.uk/dataset/952421

ec-da63-4569-817d-

4d6399df40a1/provi

https://environment.data.gov.uk/spatialdata/agric

ultural-land-classification-provisional-

england/wfs  

mailto:ebn@naturalengland.org.uk
https://www.data.gov.uk/dataset/952421ec-da63-4569-817d-4d6399df40a1/provisional-agricultural-land-classification-alc
https://www.data.gov.uk/dataset/952421ec-da63-4569-817d-4d6399df40a1/provisional-agricultural-land-classification-alc
https://www.data.gov.uk/dataset/952421ec-da63-4569-817d-4d6399df40a1/provisional-agricultural-land-classification-alc
https://www.data.gov.uk/dataset/952421ec-da63-4569-817d-4d6399df40a1/provisional-agricultural-land-classification-alc
https://environment.data.gov.uk/spatialdata/agricultural-land-classification-provisional-england/wfs
https://environment.data.gov.uk/spatialdata/agricultural-land-classification-provisional-england/wfs
https://environment.data.gov.uk/spatialdata/agricultural-land-classification-provisional-england/wfs
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Indicator Data source 

webpage 

Server Link 

sional-agricultural-

land-classification-

alc  

Agricultural 

Land 

Classification 

https://www.data.go

v.uk/dataset/c002ce

ea-d650-4408-b302-

939e9b88eb0b/agric

ultural-land-

classification-alc-

grades-post-1988-

survey-polygons  

https://environment.data.gov.uk/spatialdata/agric

ultural-land-classification-grades-post-1988-

survey-england/wfs  

Surface Water 

Availability 

https://www.data.go

v.uk/dataset/b1f5c4

67-ed41-4e8f-89d7-

f79a76645fd6/water-

resource-availability-

and-abstraction-

reliability-cycle-2  

https://environment.data.gov.uk/spatialdata/wate

r-resource-availability-and-abstraction-reliability-

cycle-2/wfs  

Groundwater 

Availability 

https://www.data.go

v.uk/dataset/2a74cf

2e-560a-4408-a762-

cad0e06c9d3f/wfd-

groundwater-bodies-

cycle-2  

https://environment.data.gov.uk/spatialdata/wfd-

groundwater-bodies-cycle-2/wfs  

Groundwater 

Availability 

https://www.data.go

v.uk/dataset/c5a3e8

77-12c3-4e81-8603-

d2d205d52d7a/wfd-

river-canal-and-

surface-water-

transfer-

waterbodies-cycle-2  

https://environment.data.gov.uk/spatialdata/wfd-

groundwater-bodies-cycle-2-2019/wfs  

Natural Flood 

Management 

Priority 

https://www.data.go

v.uk/dataset/2a4bcf

6e-3880-4c0b-9986-

6cafbec89faf/spatial

https://environment.data.gov.uk/spatialdata/spati

al-prioritisation-of-catchments-suitable-for-using-

natural-flood-management/wfs  

https://www.data.gov.uk/dataset/952421ec-da63-4569-817d-4d6399df40a1/provisional-agricultural-land-classification-alc
https://www.data.gov.uk/dataset/952421ec-da63-4569-817d-4d6399df40a1/provisional-agricultural-land-classification-alc
https://www.data.gov.uk/dataset/952421ec-da63-4569-817d-4d6399df40a1/provisional-agricultural-land-classification-alc
https://www.data.gov.uk/dataset/c002ceea-d650-4408-b302-939e9b88eb0b/agricultural-land-classification-alc-grades-post-1988-survey-polygons
https://www.data.gov.uk/dataset/c002ceea-d650-4408-b302-939e9b88eb0b/agricultural-land-classification-alc-grades-post-1988-survey-polygons
https://www.data.gov.uk/dataset/c002ceea-d650-4408-b302-939e9b88eb0b/agricultural-land-classification-alc-grades-post-1988-survey-polygons
https://www.data.gov.uk/dataset/c002ceea-d650-4408-b302-939e9b88eb0b/agricultural-land-classification-alc-grades-post-1988-survey-polygons
https://www.data.gov.uk/dataset/c002ceea-d650-4408-b302-939e9b88eb0b/agricultural-land-classification-alc-grades-post-1988-survey-polygons
https://www.data.gov.uk/dataset/c002ceea-d650-4408-b302-939e9b88eb0b/agricultural-land-classification-alc-grades-post-1988-survey-polygons
https://www.data.gov.uk/dataset/c002ceea-d650-4408-b302-939e9b88eb0b/agricultural-land-classification-alc-grades-post-1988-survey-polygons
https://www.data.gov.uk/dataset/c002ceea-d650-4408-b302-939e9b88eb0b/agricultural-land-classification-alc-grades-post-1988-survey-polygons
https://environment.data.gov.uk/spatialdata/agricultural-land-classification-grades-post-1988-survey-england/wfs
https://environment.data.gov.uk/spatialdata/agricultural-land-classification-grades-post-1988-survey-england/wfs
https://environment.data.gov.uk/spatialdata/agricultural-land-classification-grades-post-1988-survey-england/wfs
https://www.data.gov.uk/dataset/b1f5c467-ed41-4e8f-89d7-f79a76645fd6/water-resource-availability-and-abstraction-reliability-cycle-2
https://www.data.gov.uk/dataset/b1f5c467-ed41-4e8f-89d7-f79a76645fd6/water-resource-availability-and-abstraction-reliability-cycle-2
https://www.data.gov.uk/dataset/b1f5c467-ed41-4e8f-89d7-f79a76645fd6/water-resource-availability-and-abstraction-reliability-cycle-2
https://www.data.gov.uk/dataset/b1f5c467-ed41-4e8f-89d7-f79a76645fd6/water-resource-availability-and-abstraction-reliability-cycle-2
https://www.data.gov.uk/dataset/b1f5c467-ed41-4e8f-89d7-f79a76645fd6/water-resource-availability-and-abstraction-reliability-cycle-2
https://www.data.gov.uk/dataset/b1f5c467-ed41-4e8f-89d7-f79a76645fd6/water-resource-availability-and-abstraction-reliability-cycle-2
https://www.data.gov.uk/dataset/b1f5c467-ed41-4e8f-89d7-f79a76645fd6/water-resource-availability-and-abstraction-reliability-cycle-2
https://environment.data.gov.uk/spatialdata/water-resource-availability-and-abstraction-reliability-cycle-2/wfs
https://environment.data.gov.uk/spatialdata/water-resource-availability-and-abstraction-reliability-cycle-2/wfs
https://environment.data.gov.uk/spatialdata/water-resource-availability-and-abstraction-reliability-cycle-2/wfs
https://www.data.gov.uk/dataset/2a74cf2e-560a-4408-a762-cad0e06c9d3f/wfd-groundwater-bodies-cycle-2
https://www.data.gov.uk/dataset/2a74cf2e-560a-4408-a762-cad0e06c9d3f/wfd-groundwater-bodies-cycle-2
https://www.data.gov.uk/dataset/2a74cf2e-560a-4408-a762-cad0e06c9d3f/wfd-groundwater-bodies-cycle-2
https://www.data.gov.uk/dataset/2a74cf2e-560a-4408-a762-cad0e06c9d3f/wfd-groundwater-bodies-cycle-2
https://www.data.gov.uk/dataset/2a74cf2e-560a-4408-a762-cad0e06c9d3f/wfd-groundwater-bodies-cycle-2
https://www.data.gov.uk/dataset/2a74cf2e-560a-4408-a762-cad0e06c9d3f/wfd-groundwater-bodies-cycle-2
https://environment.data.gov.uk/spatialdata/wfd-groundwater-bodies-cycle-2/wfs
https://environment.data.gov.uk/spatialdata/wfd-groundwater-bodies-cycle-2/wfs
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://environment.data.gov.uk/spatialdata/wfd-groundwater-bodies-cycle-2-2019/wfs
https://environment.data.gov.uk/spatialdata/wfd-groundwater-bodies-cycle-2-2019/wfs
https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://environment.data.gov.uk/spatialdata/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management/wfs
https://environment.data.gov.uk/spatialdata/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management/wfs
https://environment.data.gov.uk/spatialdata/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management/wfs
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Indicator Data source 

webpage 

Server Link 

-prioritisation-of-

catchments-

suitable-for-using-

natural-flood-

management  

Water Quality 

WFD Status 

https://www.data.go

v.uk/dataset/d88923

dc-a394-4bbb-9f99-

ca9d2d55f689/wfd-

lake-water-bodies-

cycle-2-

classification-2019  

https://environment.data.gov.uk/spatialdata/wfd-

lake-water-bodies-cycle-2-2019/wfs  

Water Quality 

WFD Status 

https://www.data.go

v.uk/dataset/0f6c2a

ee-3f8e-476c-93df-

e629881bd985/wfd-

transitional-and-

coastal-water-

bodies-cycle-2-

classification-2019  

https://environment.data.gov.uk/spatialdata/wfd-

transitional-and-coastal-water-bodies-cycle-2-

2019/wfs  

Water Quality 

WFD Status 

https://www.data.go

v.uk/dataset/c5a3e8

77-12c3-4e81-8603-

d2d205d52d7a/wfd-

river-canal-and-

surface-water-

transfer-

waterbodies-cycle-2  

https://environment.data.gov.uk/spatialdata/wfd-

river-canal-and-swt-water-bodies-cycle-2-

2019/wfs  

Water Quality 

Management 

Area 

https://data-

forestry.opendata.ar

cgis.com/datasets/df

71f328b77f42dca80

691b77e01aae6_0/e

xplore  

https://services2.arcgis.com/mHXjwgl3OARRqq

D4/arcgis/rest/services/EWCO_Water_Quality/F

eatureServer/0  

https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://www.data.gov.uk/dataset/2a4bcf6e-3880-4c0b-9986-6cafbec89faf/spatial-prioritisation-of-catchments-suitable-for-using-natural-flood-management
https://www.data.gov.uk/dataset/d88923dc-a394-4bbb-9f99-ca9d2d55f689/wfd-lake-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/d88923dc-a394-4bbb-9f99-ca9d2d55f689/wfd-lake-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/d88923dc-a394-4bbb-9f99-ca9d2d55f689/wfd-lake-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/d88923dc-a394-4bbb-9f99-ca9d2d55f689/wfd-lake-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/d88923dc-a394-4bbb-9f99-ca9d2d55f689/wfd-lake-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/d88923dc-a394-4bbb-9f99-ca9d2d55f689/wfd-lake-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/d88923dc-a394-4bbb-9f99-ca9d2d55f689/wfd-lake-water-bodies-cycle-2-classification-2019
https://environment.data.gov.uk/spatialdata/wfd-lake-water-bodies-cycle-2-2019/wfs
https://environment.data.gov.uk/spatialdata/wfd-lake-water-bodies-cycle-2-2019/wfs
https://www.data.gov.uk/dataset/0f6c2aee-3f8e-476c-93df-e629881bd985/wfd-transitional-and-coastal-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/0f6c2aee-3f8e-476c-93df-e629881bd985/wfd-transitional-and-coastal-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/0f6c2aee-3f8e-476c-93df-e629881bd985/wfd-transitional-and-coastal-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/0f6c2aee-3f8e-476c-93df-e629881bd985/wfd-transitional-and-coastal-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/0f6c2aee-3f8e-476c-93df-e629881bd985/wfd-transitional-and-coastal-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/0f6c2aee-3f8e-476c-93df-e629881bd985/wfd-transitional-and-coastal-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/0f6c2aee-3f8e-476c-93df-e629881bd985/wfd-transitional-and-coastal-water-bodies-cycle-2-classification-2019
https://www.data.gov.uk/dataset/0f6c2aee-3f8e-476c-93df-e629881bd985/wfd-transitional-and-coastal-water-bodies-cycle-2-classification-2019
https://environment.data.gov.uk/spatialdata/wfd-transitional-and-coastal-water-bodies-cycle-2-2019/wfs
https://environment.data.gov.uk/spatialdata/wfd-transitional-and-coastal-water-bodies-cycle-2-2019/wfs
https://environment.data.gov.uk/spatialdata/wfd-transitional-and-coastal-water-bodies-cycle-2-2019/wfs
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://www.data.gov.uk/dataset/c5a3e877-12c3-4e81-8603-d2d205d52d7a/wfd-river-canal-and-surface-water-transfer-waterbodies-cycle-2
https://environment.data.gov.uk/spatialdata/wfd-river-canal-and-swt-water-bodies-cycle-2-2019/wfs
https://environment.data.gov.uk/spatialdata/wfd-river-canal-and-swt-water-bodies-cycle-2-2019/wfs
https://environment.data.gov.uk/spatialdata/wfd-river-canal-and-swt-water-bodies-cycle-2-2019/wfs
https://data-forestry.opendata.arcgis.com/datasets/df71f328b77f42dca80691b77e01aae6_0/explore
https://data-forestry.opendata.arcgis.com/datasets/df71f328b77f42dca80691b77e01aae6_0/explore
https://data-forestry.opendata.arcgis.com/datasets/df71f328b77f42dca80691b77e01aae6_0/explore
https://data-forestry.opendata.arcgis.com/datasets/df71f328b77f42dca80691b77e01aae6_0/explore
https://data-forestry.opendata.arcgis.com/datasets/df71f328b77f42dca80691b77e01aae6_0/explore
https://data-forestry.opendata.arcgis.com/datasets/df71f328b77f42dca80691b77e01aae6_0/explore
https://services2.arcgis.com/mHXjwgl3OARRqqD4/arcgis/rest/services/EWCO_Water_Quality/FeatureServer/0
https://services2.arcgis.com/mHXjwgl3OARRqqD4/arcgis/rest/services/EWCO_Water_Quality/FeatureServer/0
https://services2.arcgis.com/mHXjwgl3OARRqqD4/arcgis/rest/services/EWCO_Water_Quality/FeatureServer/0
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Indicator Data source 

webpage 

Server Link 

Rainfall https://climatedatap

ortal.metoffice.gov.u

k/datasets/TheMetO

ffice::annual-

precipitation-

observations-1991-

2020-12km/about  

https://services.arcgis.com/Lq3V5RFuTBC9I7kv/

arcgis/rest/services/Annual_Precipitation_Obser

vations_1991_2020/FeatureServer/0  

Soil Drainage - - 

Population 

Density 

- - 

Nature 

Designation 

https://environment.

data.gov.uk/dataset/

c626e031-e561-

4861-8219-

b04cd1002806  

https://environment.data.gov.uk/spatialdata/rams

ar-england/wfs  

Nature 

Designation 

https://www.data.go

v.uk/dataset/a85e64

d9-d0f1-4500-9080-

b0e29b81fbc8/speci

al-areas-of-

conservation-

england  

https://environment.data.gov.uk/spatialdata/speci

al-areas-of-conservation-england/wfs  

Nature 

Designation 

https://www.data.go

v.uk/dataset/174f4e

23-acb6-4305-9365-

1e33c8d0e455/spec

ial-protection-areas-

england  

https://environment.data.gov.uk/spatialdata/speci

al-protection-areas-england/wfs  

Nature 

Designation 

https://environment.

data.gov.uk/dataset/

ff213e4c-423a-

4d7e-9e6f-

b220600a8db3  

https://environment.data.gov.uk/spatialdata/natio

nal-nature-reserves-england/wfs  

https://climatedataportal.metoffice.gov.uk/datasets/TheMetOffice::annual-precipitation-observations-1991-2020-12km/about
https://climatedataportal.metoffice.gov.uk/datasets/TheMetOffice::annual-precipitation-observations-1991-2020-12km/about
https://climatedataportal.metoffice.gov.uk/datasets/TheMetOffice::annual-precipitation-observations-1991-2020-12km/about
https://climatedataportal.metoffice.gov.uk/datasets/TheMetOffice::annual-precipitation-observations-1991-2020-12km/about
https://climatedataportal.metoffice.gov.uk/datasets/TheMetOffice::annual-precipitation-observations-1991-2020-12km/about
https://climatedataportal.metoffice.gov.uk/datasets/TheMetOffice::annual-precipitation-observations-1991-2020-12km/about
https://climatedataportal.metoffice.gov.uk/datasets/TheMetOffice::annual-precipitation-observations-1991-2020-12km/about
https://services.arcgis.com/Lq3V5RFuTBC9I7kv/arcgis/rest/services/Annual_Precipitation_Observations_1991_2020/FeatureServer/0
https://services.arcgis.com/Lq3V5RFuTBC9I7kv/arcgis/rest/services/Annual_Precipitation_Observations_1991_2020/FeatureServer/0
https://services.arcgis.com/Lq3V5RFuTBC9I7kv/arcgis/rest/services/Annual_Precipitation_Observations_1991_2020/FeatureServer/0
https://environment.data.gov.uk/dataset/c626e031-e561-4861-8219-b04cd1002806
https://environment.data.gov.uk/dataset/c626e031-e561-4861-8219-b04cd1002806
https://environment.data.gov.uk/dataset/c626e031-e561-4861-8219-b04cd1002806
https://environment.data.gov.uk/dataset/c626e031-e561-4861-8219-b04cd1002806
https://environment.data.gov.uk/dataset/c626e031-e561-4861-8219-b04cd1002806
https://environment.data.gov.uk/spatialdata/ramsar-england/wfs
https://environment.data.gov.uk/spatialdata/ramsar-england/wfs
https://www.data.gov.uk/dataset/a85e64d9-d0f1-4500-9080-b0e29b81fbc8/special-areas-of-conservation-england
https://www.data.gov.uk/dataset/a85e64d9-d0f1-4500-9080-b0e29b81fbc8/special-areas-of-conservation-england
https://www.data.gov.uk/dataset/a85e64d9-d0f1-4500-9080-b0e29b81fbc8/special-areas-of-conservation-england
https://www.data.gov.uk/dataset/a85e64d9-d0f1-4500-9080-b0e29b81fbc8/special-areas-of-conservation-england
https://www.data.gov.uk/dataset/a85e64d9-d0f1-4500-9080-b0e29b81fbc8/special-areas-of-conservation-england
https://www.data.gov.uk/dataset/a85e64d9-d0f1-4500-9080-b0e29b81fbc8/special-areas-of-conservation-england
https://www.data.gov.uk/dataset/a85e64d9-d0f1-4500-9080-b0e29b81fbc8/special-areas-of-conservation-england
https://environment.data.gov.uk/spatialdata/special-areas-of-conservation-england/wfs
https://environment.data.gov.uk/spatialdata/special-areas-of-conservation-england/wfs
https://www.data.gov.uk/dataset/174f4e23-acb6-4305-9365-1e33c8d0e455/special-protection-areas-england
https://www.data.gov.uk/dataset/174f4e23-acb6-4305-9365-1e33c8d0e455/special-protection-areas-england
https://www.data.gov.uk/dataset/174f4e23-acb6-4305-9365-1e33c8d0e455/special-protection-areas-england
https://www.data.gov.uk/dataset/174f4e23-acb6-4305-9365-1e33c8d0e455/special-protection-areas-england
https://www.data.gov.uk/dataset/174f4e23-acb6-4305-9365-1e33c8d0e455/special-protection-areas-england
https://www.data.gov.uk/dataset/174f4e23-acb6-4305-9365-1e33c8d0e455/special-protection-areas-england
https://environment.data.gov.uk/spatialdata/special-protection-areas-england/wfs
https://environment.data.gov.uk/spatialdata/special-protection-areas-england/wfs
https://environment.data.gov.uk/dataset/ff213e4c-423a-4d7e-9e6f-b220600a8db3
https://environment.data.gov.uk/dataset/ff213e4c-423a-4d7e-9e6f-b220600a8db3
https://environment.data.gov.uk/dataset/ff213e4c-423a-4d7e-9e6f-b220600a8db3
https://environment.data.gov.uk/dataset/ff213e4c-423a-4d7e-9e6f-b220600a8db3
https://environment.data.gov.uk/dataset/ff213e4c-423a-4d7e-9e6f-b220600a8db3
https://environment.data.gov.uk/spatialdata/national-nature-reserves-england/wfs
https://environment.data.gov.uk/spatialdata/national-nature-reserves-england/wfs
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Indicator Data source 

webpage 

Server Link 

Nature 

Designation 

https://www.data.go

v.uk/dataset/acdf4a

9e-a115-41fb-bbe9-

603c819aa7f7/local-

nature-reserves-

england  

https://environment.data.gov.uk/spatialdata/local

-nature-reserves-england/wfs  

Nature 

Designation 

https://www.data.go

v.uk/dataset/5b632b

d7-9838-4ef2-9101-

ea9384421b0d/sites

-of-special-scientific-

interest-england  

https://environment.data.gov.uk/spatialdata/sites

-of-special-scientific-interest-england/wfs  

Nature 

Designation 

https://environment.

data.gov.uk/dataset/

e819098e-e248-

4a8f-b684-

5a21ca521b9b  

https://environment.data.gov.uk/spatialdata/natio

nal-parks-england/wfs  

Nature 

Designation 

https://www.data.go

v.uk/dataset/80c075

c3-1880-44a0-bffc-

69e20f307c21/marin

e-conservation-

zones-england  

https://environment.data.gov.uk/spatialdata/mari

ne-conservation-zones-england/wfs  

Ancient 

Habitat 

https://www.data.go

v.uk/dataset/9461f4

63-c363-4309-ae77-

fdcd7e9df7d3/ancie

nt-woodland-

england  

https://environment.data.gov.uk/spatialdata/anci

ent-woodland-england/wfs  

Cultural or 

Historic 

Importance 

https://environment.

data.gov.uk/dataset/

e819098e-e248-

4a8f-b684-

5a21ca521b9b  

https://environment.data.gov.uk/spatialdata/natio

nal-parks-england/wfs  

https://www.data.gov.uk/dataset/acdf4a9e-a115-41fb-bbe9-603c819aa7f7/local-nature-reserves-england
https://www.data.gov.uk/dataset/acdf4a9e-a115-41fb-bbe9-603c819aa7f7/local-nature-reserves-england
https://www.data.gov.uk/dataset/acdf4a9e-a115-41fb-bbe9-603c819aa7f7/local-nature-reserves-england
https://www.data.gov.uk/dataset/acdf4a9e-a115-41fb-bbe9-603c819aa7f7/local-nature-reserves-england
https://www.data.gov.uk/dataset/acdf4a9e-a115-41fb-bbe9-603c819aa7f7/local-nature-reserves-england
https://www.data.gov.uk/dataset/acdf4a9e-a115-41fb-bbe9-603c819aa7f7/local-nature-reserves-england
https://environment.data.gov.uk/spatialdata/local-nature-reserves-england/wfs
https://environment.data.gov.uk/spatialdata/local-nature-reserves-england/wfs
https://www.data.gov.uk/dataset/5b632bd7-9838-4ef2-9101-ea9384421b0d/sites-of-special-scientific-interest-england
https://www.data.gov.uk/dataset/5b632bd7-9838-4ef2-9101-ea9384421b0d/sites-of-special-scientific-interest-england
https://www.data.gov.uk/dataset/5b632bd7-9838-4ef2-9101-ea9384421b0d/sites-of-special-scientific-interest-england
https://www.data.gov.uk/dataset/5b632bd7-9838-4ef2-9101-ea9384421b0d/sites-of-special-scientific-interest-england
https://www.data.gov.uk/dataset/5b632bd7-9838-4ef2-9101-ea9384421b0d/sites-of-special-scientific-interest-england
https://www.data.gov.uk/dataset/5b632bd7-9838-4ef2-9101-ea9384421b0d/sites-of-special-scientific-interest-england
https://environment.data.gov.uk/spatialdata/sites-of-special-scientific-interest-england/wfs
https://environment.data.gov.uk/spatialdata/sites-of-special-scientific-interest-england/wfs
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/spatialdata/national-parks-england/wfs
https://environment.data.gov.uk/spatialdata/national-parks-england/wfs
https://www.data.gov.uk/dataset/80c075c3-1880-44a0-bffc-69e20f307c21/marine-conservation-zones-england
https://www.data.gov.uk/dataset/80c075c3-1880-44a0-bffc-69e20f307c21/marine-conservation-zones-england
https://www.data.gov.uk/dataset/80c075c3-1880-44a0-bffc-69e20f307c21/marine-conservation-zones-england
https://www.data.gov.uk/dataset/80c075c3-1880-44a0-bffc-69e20f307c21/marine-conservation-zones-england
https://www.data.gov.uk/dataset/80c075c3-1880-44a0-bffc-69e20f307c21/marine-conservation-zones-england
https://www.data.gov.uk/dataset/80c075c3-1880-44a0-bffc-69e20f307c21/marine-conservation-zones-england
https://environment.data.gov.uk/spatialdata/marine-conservation-zones-england/wfs
https://environment.data.gov.uk/spatialdata/marine-conservation-zones-england/wfs
https://www.data.gov.uk/dataset/9461f463-c363-4309-ae77-fdcd7e9df7d3/ancient-woodland-england
https://www.data.gov.uk/dataset/9461f463-c363-4309-ae77-fdcd7e9df7d3/ancient-woodland-england
https://www.data.gov.uk/dataset/9461f463-c363-4309-ae77-fdcd7e9df7d3/ancient-woodland-england
https://www.data.gov.uk/dataset/9461f463-c363-4309-ae77-fdcd7e9df7d3/ancient-woodland-england
https://www.data.gov.uk/dataset/9461f463-c363-4309-ae77-fdcd7e9df7d3/ancient-woodland-england
https://www.data.gov.uk/dataset/9461f463-c363-4309-ae77-fdcd7e9df7d3/ancient-woodland-england
https://environment.data.gov.uk/spatialdata/ancient-woodland-england/wfs
https://environment.data.gov.uk/spatialdata/ancient-woodland-england/wfs
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/spatialdata/national-parks-england/wfs
https://environment.data.gov.uk/spatialdata/national-parks-england/wfs
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Indicator Data source 

webpage 

Server Link 

Cultural or 

Historic 

Importance 

https://www.data.go

v.uk/dataset/8e3ae3

b9-a827-47f1-b025-

f08527a4e84e/areas

-of-outstanding-

natural-beauty-

england  

https://environment.data.gov.uk/spatialdata/area

s-of-outstanding-natural-beauty-england/wfs  

Cultural or 

Historic 

Importance 

https://environment.

data.gov.uk/dataset/

3c27e15d-e906-

413b-8497-

11c07a2230fe  

https://environment.data.gov.uk/spatialdata/herit

age-coasts-england/wfs  

Cultural or 

Historic 

Importance - 

Scheduled 

Monuments 

https://www.data.go

v.uk/dataset/d53bd2

32-16e7-4867-8d10-

b313ef41ac22/natio

nal-heritage-list-for-

england-nhle  

https://services-

eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/r

est/services/National_Heritage_List_for_England

_NHLE_v02_VIEW/FeatureServer/6 

 

Cultural or 

Historic 

Importance - 

Parks and 

Gardens 

https://www.data.go

v.uk/dataset/d53bd2

32-16e7-4867-8d10-

b313ef41ac22/natio

nal-heritage-list-for-

england-nhle  

https://services-

eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/r

est/services/National_Heritage_List_for_England

_NHLE_v02_VIEW/FeatureServer/7 

 

Cultural or 

Historic 

Importance - 

Battlefields 

https://www.data.go

v.uk/dataset/d53bd2

32-16e7-4867-8d10-

b313ef41ac22/natio

nal-heritage-list-for-

england-nhle  

https://services-

eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/r

est/services/National_Heritage_List_for_England

_NHLE_v02_VIEW/FeatureServer/8 

 

Special 

Recreation 

Value 

https://environment.

data.gov.uk/dataset/

e819098e-e248-

4a8f-b684-

5a21ca521b9b  

https://environment.data.gov.uk/spatialdata/natio

nal-parks-england/wfs  

https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://environment.data.gov.uk/spatialdata/areas-of-outstanding-natural-beauty-england/wfs
https://environment.data.gov.uk/spatialdata/areas-of-outstanding-natural-beauty-england/wfs
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/spatialdata/heritage-coasts-england/wfs
https://environment.data.gov.uk/spatialdata/heritage-coasts-england/wfs
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/6
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/6
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/6
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/6
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/7
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/7
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/7
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/7
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://www.data.gov.uk/dataset/d53bd232-16e7-4867-8d10-b313ef41ac22/national-heritage-list-for-england-nhle
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/8
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/8
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/8
https://services-eu1.arcgis.com/ZOdPfBS3aqqDYPUQ/ArcGIS/rest/services/National_Heritage_List_for_England_NHLE_v02_VIEW/FeatureServer/8
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/dataset/e819098e-e248-4a8f-b684-5a21ca521b9b
https://environment.data.gov.uk/spatialdata/national-parks-england/wfs
https://environment.data.gov.uk/spatialdata/national-parks-england/wfs
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Indicator Data source 

webpage 

Server Link 

Special 

Recreation 

Value 

https://www.data.go

v.uk/dataset/8e3ae3

b9-a827-47f1-b025-

f08527a4e84e/areas

-of-outstanding-

natural-beauty-

england  

https://environment.data.gov.uk/spatialdata/area

s-of-outstanding-natural-beauty-england/wfs  

Special 

Recreation 

Value 

https://environment.

data.gov.uk/dataset/

3c27e15d-e906-

413b-8497-

11c07a2230fe  

https://environment.data.gov.uk/spatialdata/herit

age-coasts-england/wfs  

Public Access - - 

Educational 

Use 

- - 

Managed for 

Nature 

https://www.data.go

v.uk/dataset/78d770

39-e3ae-4840-828f-

82898ddc910e/coun

tryside-stewardship-

scheme-2016-

management-areas-

england  

https://environment.data.gov.uk/spatialdata/coun

tryside-stewardship-scheme-2016-management-

areas/wfs  

Landscape 

Diversity 

- - 

 

  

https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://www.data.gov.uk/dataset/8e3ae3b9-a827-47f1-b025-f08527a4e84e/areas-of-outstanding-natural-beauty-england
https://environment.data.gov.uk/spatialdata/areas-of-outstanding-natural-beauty-england/wfs
https://environment.data.gov.uk/spatialdata/areas-of-outstanding-natural-beauty-england/wfs
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/dataset/3c27e15d-e906-413b-8497-11c07a2230fe
https://environment.data.gov.uk/spatialdata/heritage-coasts-england/wfs
https://environment.data.gov.uk/spatialdata/heritage-coasts-england/wfs
https://www.data.gov.uk/dataset/78d77039-e3ae-4840-828f-82898ddc910e/countryside-stewardship-scheme-2016-management-areas-england
https://www.data.gov.uk/dataset/78d77039-e3ae-4840-828f-82898ddc910e/countryside-stewardship-scheme-2016-management-areas-england
https://www.data.gov.uk/dataset/78d77039-e3ae-4840-828f-82898ddc910e/countryside-stewardship-scheme-2016-management-areas-england
https://www.data.gov.uk/dataset/78d77039-e3ae-4840-828f-82898ddc910e/countryside-stewardship-scheme-2016-management-areas-england
https://www.data.gov.uk/dataset/78d77039-e3ae-4840-828f-82898ddc910e/countryside-stewardship-scheme-2016-management-areas-england
https://www.data.gov.uk/dataset/78d77039-e3ae-4840-828f-82898ddc910e/countryside-stewardship-scheme-2016-management-areas-england
https://www.data.gov.uk/dataset/78d77039-e3ae-4840-828f-82898ddc910e/countryside-stewardship-scheme-2016-management-areas-england
https://www.data.gov.uk/dataset/78d77039-e3ae-4840-828f-82898ddc910e/countryside-stewardship-scheme-2016-management-areas-england
https://environment.data.gov.uk/spatialdata/countryside-stewardship-scheme-2016-management-areas/wfs
https://environment.data.gov.uk/spatialdata/countryside-stewardship-scheme-2016-management-areas/wfs
https://environment.data.gov.uk/spatialdata/countryside-stewardship-scheme-2016-management-areas/wfs
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Annex 2. Updates to Data Layers (2025) 

V1.1 makes the following  changes to the 002 Indicator Data Import to account to 

changes in the data layers referred to by 031 Nature Designation, 

SSSI - Retain Field 

change sssi_name; to label; 

SSSI - Rename field 

change sssi_name to label 

NNR - Retain fields 

Changed nnr_name; to label; 

NNR - Rename field 

Change nnr_name to label 

LNR Retain fields 

Change lnr_name; to label; 

LNR- Rename field 

Change lnr_name to label 
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